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Introduction

The What’s New in QuarkXPress 8? guide is for experienced QuarkXPress® users

who want to work faster with the updated user interface. The guide also includes

descriptions of new features. For more information about a feature, consult

A Guide to QuarkXPress 8 or the QuarkXPress Help file.

INTRODUCTION
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Chapter 1: Working faster
with QuarkXPress 8

With a streamlined tool set, external drag-and-drop, and Item Styles,

QuarkXPress 8 is designed to help you get your work done faster and more

efficiently than ever before.

FLEXIBLE CONTENT HANDLING

In earlier versions of QuarkXPress, you had to create a text box before you could
import text, and you had to create a picture box before you could insert a picture.
With QuarkXPress 8, you simply draw a “plain” box, then choose File > Import
and import a text or picture file. If you want to change a picture box to a text
box, you can just select it and import a text file. In fact, you don’t even have to
draw a box — simply choose File > Import and select a file, and QuarkXPress
creates the box for you.

DIRECT MANIPULATION OF BOXES AND PICTURES

QuarkXPress 8 introduces direct manipulation, which is a faster and easier way
of resizing and rotating boxes and pictures.

In earlier versions of QuarkXPress, you had to select the Rotation tool to rotate
a box. With QuarkXPress 8, you can just move your mouse pointer near an item’s
corner handle until the rotation pointer displays, and then click and drag.
Move the mouse a little closer to a handle, and the resize pointer displays,
allowing you to resize the box.

Pictures in picture boxes now have their own handles , too, allowing you
to rotate and resize them without switching tools. You can even see a ghosted
version of the cropped-out portion of the active picture.

FLEXIBLE CONTENT HANDLING
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Use picture handles to rotate pictures.

EASIER ITEM DUPLICATION

To duplicate an item, click and drag the item and press Option/Alt before you
release the mouse button. A copy of the item comes with the mouse pointer,
and the original stays behind. 

RESIZING FROM THE CENTER

To resize an item from its center, click and drag a handle and press Option/Alt
before you release the mouse button.

NEW TOOLS

QuarkXPress 8 Tools palette

DIRECT MANIPULATION OF BOXES AND PICTURES
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QuarkXPress 8 comes with a completely revamped Tools palette. The tools
(old and new) are summarized below.

• Item tool: Double-clicking with the Item tool now works more intelligently.
For example, you can double-click a text box to switch to the Text Content
tool for text editing, or double-click a picture box to import a file or modify the
box. Preferences let you control what happens when you double-click a box.

• Text Content tool: Use the Text Content tool to edit text. You can also use
the Text Content tool to draw a rectangular text box and immediately switch
to text editing mode.

• Text Linking tool: Use the Text Linking tool to flow text between boxes.

• Text Unlinking tool: Use the Text Unlinking tool to break the flow of text
between boxes.

• Picture Content tool: Use the Picture Content tool to work with pictures in
picture boxes. You can also use the Picture Content tool to draw a rectangular
picture box and immediately import a picture.

• Rectangular Box tool: Use the Rectangular Box tool to create rectangular
boxes that accept both text and pictures.

• Oval Box tool: Use the Oval Box tool to create oval-shaped boxes. Press Shift
to create circular boxes that accept both text and pictures.

• Starburst tool: Use the Starburst tool to create star-shaped boxes that accept
both text and pictures.

• Composition Zones tool: Use the Composition Zones tool to create
Composition Zones® items.

• Line tool: Use the Line tool to create straight lines at any angle. To constrain
lines to 45-degree angles, press Shift before drawing.

• Bézier Pen tool: Use the Bézier Pen tool to draw and edit Bézier lines and
boxes. A comprehensive set of modifier key commands makes it easy for you
to create, edit, and adjust Bézier lines without having to switch tools.

• Add Point tool: Use the Add Point tool to add a point to a Bézier line or box
segment. (You can also add a point to an existing path by clicking the path with
the Bézier Pen tool.)

• Remove Point tool: Use the Remove Point tool to delete a point from a
Bézier line or box segment. (You can also remove a point by clicking it with
the Bézier Pen tool.)

• Convert Point tool: Use the Convert Point tool to convert a Bézier point or
line segment to a different type. (You can also convert a point or line segment
by Option+clicking/Alt+clicking with the Bézier Pen tool.)

• Scissors tool: Use the Scissors tool to “cut” a box or line segment by adding
Bézier points.

NEW TOOLS
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• Select Point tool: Use the Select Point tool to select a Bézier point.

• Freehand Drawing tool: Use the Freehand Drawing tool to draw a line with
a continuous motion.

• Table tool: Use the Table tool to create tables.

• Zoom tool: Use the Zoom tool to zoom in on the layout. Press Option/Alt
and click to zoom out.

• Pan tool: Use the Pan tool to scroll the layout in any direction.

KEYBOARD SHORTCUTS FOR SWITCHING TOOLS

When you’re not working with text, you can use the following keys to switch
between tools:

• V = Item tool

• T = Text Content tool, Text Linking tool, Text Unlinking tool

• R = Picture Content tool

• B = Rectangle Box tool, Oval Box tool, Star Box tool, Composition Zones tool

• L = Line tool

• P = Bézier Pen tool, Add Point tool, Remove Point tool, Convert Point tool,
Scissors tool, Select Point tool, Freehand Drawing tool

• G = Table tool

• Z = Zoom tool

You can cycle through tools that share the same shortcut key by pressing that
key repeatedly.

OLD TOOLS AND NEW TOOLS

The topics below list the old QuarkXPress tools and show where to look for the
corresponding tools in QuarkXPress 8.

ITEM TOOL

Item tool

The Item tool works the same way it did in previous versions.

CONTENT TOOL 

Content tool

The Content tool has been replaced by the Text Content tool and
Picture Content tool. 

NEW TOOLS
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ROTATION TOOL 

Rotation tool

The Rotation tool has been removed from the Tools palette. You can now rotate
an item or picture by clicking and dragging near a box corner when the rotation
pointer <icon_rotate_pointer.jpg> displays. 

ZOOM TOOL 

Zoom tool

The Zoom tool has been moved to a group at the bottom of the Tools palette.

TEXT BOX AND PICTURE BOX TOOLS 

Text Box tools

Picture Box tools

Rather than drawing a text or picture box, you can now simply draw a box
and then import text or a picture. Consequently, the Text Box group and the
Picture Box group have been replaced by the Box tool group and the Bézier
tool group.

*** Corner styles are now a box attribute in QuarkXPress 8. This makes it easy for
you to change a rectangular box into a rounded-corner box, and to control the
radius of the corners.

TABLES TOOL 

Tables tool

The Tables tool works the same way it did in earlier versions.

LINE TOOLS 

Line tools

The tools in the Line tools group have been replaced by the Line tool and the
tools in the Bézier tool group. The Orthogonal Line tool has been removed,
but you can create orthogonal lines by pressing Shift before drawing.

OLD TOOLS AND NEW TOOLS
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TEXT PATH TOOLS 

Text Path tools

The tools in the Text Path group no longer exist. Instead of drawing a text path,
you can simply draw a line, and then double-click it with the Text Content tool.

LINKING TOOL 

Linking tool

The Linking tool works the same way it did in earlier versions. This tool has
been moved to the Text Content tool group.

UNLINKING TOOL 

Unlinking tool

The Unlinking tool works the same way it did in earlier versions. This tool
has been moved to the Text Content tool group.

COMPOSITION ZONES TOOL 

Composition Zones tool

The Composition Zones tool works the same way it did in earlier versions.
This tool has been moved to the Box tool group.

SCISSORS TOOL 

Scissors tool

The Scissors tool works the same way it did in earlier versions. This tool has been
moved to the Bézier tool group.

STARBURST TOOL 

Starburst tool

The Starburst tool works the same way it did in earlier versions. This tool has
been moved to the Box tool group.

TOOL SELECTION

A tool remains selected in QuarkXPress 8 until you select another tool or use a
keyboard shortcut to switch tools. 

OLD TOOLS AND NEW TOOLS
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EXTERNAL DRAG-AND-DROP

In QuarkXPress 8, you can drag text and pictures into a layout from the file
system or from another application, and you can drag text and pictures from
a layout to the file system or into another application. 

ITEM FIND/CHANGE AND ITEM STYLES

Imagine you’re laying out a cookbook that includes 55 ingredients boxes and 35
instructions boxes. After you’ve applied a green background to all 90 boxes,
the art director asks you to change the ingredients box backgrounds to yellow
and leave the instruction boxes green. Fortunately, the Item FindChange and
Item Styles features make these kinds of changes easy.

Just as the Find/Change palette (Edit menu) lets you find and change text
and text attributes, the Item FindChange palette (Edit menu) lets you find
and change item attributes. For example, you can use this palette to search
for ingredients boxes and change their backgrounds to yellow. 

Item styles are like style sheets for boxes and lines. If you have two different item
styles for the ingredients boxes and the instructions boxes, you can update the
background color of all of the ingredients boxes by simply making one change
in the Edit Item Style dialog box (Edit > Item Styles > New or Edit button).

EFFECTIVE IMAGE RESOLUTION FIELD

The Effective Image Resolution field on the Classic tab of the Measurements
palette displays the output resolution of the selected picture, given the picture’s
native resolution and any scaling applied to the picture in QuarkXPress.

WYSIWYG FONT MENU

With QuarkXPress 8, font names display in their own font by default. You can
press Shift before choosing a font list to temporarily disable this feature, or turn
it off by default in the application preferences.

BETTER BÉZIER HANDLING

The QuarkXPress Bézier tools are now more consistent with Bézier tools in other
desktop publishing applications. They are also easier to use — for example, you
can do most Bézier editing with the Bézier Pen tool and modifier keys.

EXTERNAL DRAG-AND-DROP
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DESIGN GRIDS

The Design Grid feature is an extension of the baseline grid feature in earlier
versions of QuarkXPress. In earlier versions of QuarkXPress, you had just one
baseline grid for an entire layout. In QuarkXPress 8, you can define different
baseline grids for different master pages, and even apply a baseline grid to a
text box. 

In addition to controlling the color of the baseline, you can define distinct
colors and patterns for the topline, centerline, and bottomline — all of which
can be positioned based on font size and line spacing (the distance from the
topline to the bottomline is equal to a font’s em height). When a design grid is
displayed, you can align text visually, lock text to the grid, and even snap items
to the grid. 

Design grid gridlines 

In addition to creating design grids that are specific to master pages and text
boxes, you can create grid styles that work like style sheets and item styles.
You can even link a grid style to a style sheet — so that if the style sheet changes,
the grid changes too.

ENHANCED GUIDE CONTROLS

Guide Manager Pro XTensions software gives you added control over the guides
you use for alignment. You can use the Guide Manager Pro Guide palette
(Window menu) to modify the color, placement, display, and orientation of
each guide in a layout.

For example, if you want to place a permanent guide that indicates the point
below which you don’t want content on layout pages, you can place a guide at
this point on a master page, use the Guides palette to specify a unique color,
and then lock the guide.

IMPROVED SPELL CHECKING 

You can accelerate spell checking by setting the following preferences:
Ignore words with numbers and Ignore Internet and file addresses.

DESIGN GRIDS
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ENHANCED STYLE SHEET UPDATING

If you apply a style sheet and then decide you want to change the formatting
of the style sheet, you can simply select some styled text that uses the new
formatting and then update the style sheet to match by clicking Update in the
Style Sheets palette.

IMPROVED PAGE IDENTIFICATION

In earlier versions of QuarkXPress, you might have experienced situations where
you thought you were pasting an item on page nine, only to see it land on page
seven. QuarkXPress 8 more intelligently determines which of the pages in the
project window should be active, uses distinct colors to identify active and
inactive spreads, and allows you to make a page active by simply clicking
that page.

PAGE THUMBNAILS

On Mac OS®, the pop-up page navigation control at the bottom left of the
project window can now display pages as thumbnails. To enable this feature,
click the pop-up so that the page icons display, and then press the up arrow to
switch to a thumbnail preview of the page. You can then use the up and down
arrows to change the size of the thumbnail preview or to switch back to the
icon view. 

ENHANCED STYLE SHEET UPDATING
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Chapter 2: Doing more
with QuarkXPress 8

The new features in QuarkXPress 8 allow you to accomplish more than

ever before. For example, you can create interactive Flash files, open any

QuarkXPress 8 file in any language edition of QuarkXPress 8, and import

native Adobe® Illustrator® files.

INTERACTIVE LAYOUTS AND FLASH FILE EXPORT

Previously available as a separate product, Quark Interactive Designer XTensions®

software is now part of QuarkXPress. With Quark Interactive Designer™, you
can add sophisticated interactivity to a layout and export the layout in Flash®

(SWF) format — without having to learn a scripting language.

TEXT-TO-BOX ENHANCEMENTS

In addition to converting single characters into separate text boxes, you can
now convert a line of text, the entire contents of a text box, all of the text in a
spread, or even all of the text in a linked story.

UNIVERSAL FILE FORMAT AND LANGUAGE EDITION COMPATIBILITY

In earlier versions of QuarkXPress, you could not open an East Asian project in
a non-East Asian edition of QuarkXPress. If you opened a project with French
hyphenation in a German edition of QuarkXPress, you ran the risk of text reflow.

All language editions of QuarkXPress 8 use the same universal file format. That
means you can use any language edition of QuarkXPress 8 to open and output
a project created in any other language edition of QuarkXPress 8, without reflow
due to hyphenation.

*** You must have a compatible language edition of QuarkXPress to apply, remove,
or modify certain East Asian text attributes.

INTERACTIVE LAYOUTS AND FLASH FILE EXPORT
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SUPPORT FOR NATIVE ADOBE ILLUSTRATOR FILES

QuarkXPress now allows you to import native Adobe Illustrator files saved in
Adobe Illustrator version 8 and later.

IMPROVED PDF SUPPORT

You can now import PDF 1.6 and PDF 1.7 files.

HANGING CHARACTER SETS 

The Hanging Character feature gives you precise control over paragraph bound-
aries. For example, to create a more pleasing “edge” in justified text, you can
slightly “hang” quotation marks outside the paragraph boundary — even if it
means those quotation marks are outside of the text box.

You can specify rules for “hanging characters” to fall outside the text boundaries. 

ENHANCED FONT FALLBACK 

Earlier versions of QuarkXPress offered a Font Fallback feature that could
intelligently replace missing glyphs in imported or pasted-in text by applying
fonts that contain those glyphs. QuarkXPress 8 offers an improved Font Fallback
feature that lets you specify different replacement fonts for specific scripts or
languages, including Cyrillic, Greek, Latin, and four East Asian languages. 

PPD FONT LISTING

Rather than having to query a printer for a list of its fonts, you can now use the
list of fonts in the printer’s PPD file. To do so, check Use PPD Font Settings in
the Fonts pane of the Print dialog box (File menu).

SUPPORT FOR NATIVE ADOBE ILLUSTRATOR FILES
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